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Desktop Based Geographical Management
Information System (GMIS)

Apart from infrastructure rehabilitation and improvement of
irrigation schemes, it is also necessary that any successful project
has an accountability of systematically collecting and storing spatial
and non-spatial data and information pertaining to sub projects. In
this context, the Irrigation and Water Resource Project (IWRMP)
had developed a first version of the Desktop based Geographical
Management Information System (GMIS) application through
outsourcing during 2009 to 2013. The desktop GMIS application had
features of capturing information related to subproject type- surface
and ground water with additional information related to subproject
location, social, agricultural, engineering, economic as well as
implementation and status. The mapping component were used to
capture/delineate command area, canal alignment and structures.
In addition, it also had functionalities of query, visualization and
reporting. Although this version of the software was tested and
applied in some project areas, it was discontinued due to some
severe limitations in its application — mainly related to the use of
proprietary software components and engines.

This updated desktop based GMIS 2018 was conceptualized by
IWRMP in order to overcome the limitations of the earlier version
and was outsourced for development in 2017. GMIS 2018 has been
developed maintaining the integrity of its predecessor, keeping intact
all the functionalities while using latest programming platform,
methodology and completely free open source software components
and engines. Further, errors and other redundancies in the earlier
version of the system have been successfully rectified in this version.



How to use this Manual ?

The manual has been developed for the convenience of the desktop
based GMIS user to use the GMIS 2018. It is targeted for data entry
level technicians as well as database maintaining level professionals
within the Department of Irrigation (DOI). Also, it can be a quick
reference to the decision making/executive level officers to quickly
view and map out the summary of desired projects within a spatial
domain.

The manual describes in a step-by-step manner how a new sub-
project can be created, how and existing sub-project can be edited
and how detailed data is to be entered into the system. It also
highlights the use of the GIS mapping component in which the user
can add in shape files and create features manually. And finally, the
manual describes about the reporting features of the GMIS.



Licensing

This desktop based GMIS 2018 uses the following free third party
libraries. The developed application is automatically bound by the
terms and conditions of licensing and use of the respective third-
party libraries:

NET Framework - ® NET 3.5 SP1 is a requirement for SQL Server 2014
Ewhen you select Database Engine, Reporting Services,
‘Master Data Services, Data Quality Services, Replication,
‘or SQL Server Management Studio, and it is no longer
installed by SQL Server Setup.

- ® If you run Setup and you do not have .NET 3.5 SP1,
:SQL Server Setup requires you to download and install
.NET 3.5 SP1 before you can continue with the SQL
:Server installation. (Install .NET 3.5 SP1 from Microsoft

- .NET Framework 3.5 Service Pack 1.) The error message
‘includes a link to the download center, or you can down-
‘load .NET 3.5 SP1 from Windows Update. To avoid inter- :
‘ruption during SQL Server Setup, you can download and
éinstall .NET 3.5 SP1 before you run SQL Server Setup.

® If you run Setup on a computer with Windows Server
12008 R2 SP1 or Windows 8, you must enable .NET Frame- :
:work 3.5 SP1 before you install SQL Server 2014.

- ® If there is no internet access, you must download and

‘install .NET Framework 3.5 SP1 before you run Setup to

install any of the above mentioned components. For more
‘information about the recommendations and guidance '
‘on how to acquire and enable .NET Framework 3.5 on :
‘Windows 8 and Windows Server 2012, see Microsoft .NET :
‘Framework 3.5 Deployment Considerations(http://msdn.
“microsoft.com/library/windows/hardware/hh975396).

Windows PowerShell SQL Server 2014 does not install or enable Windows
‘PowerShell 2.0; however Windows PowerShell 2.0 is an
‘installation prerequisite for Database Engine components
‘and SQL Server Management Studio. If Setup reports that
éWindows PowerShell 2.0 is not present, you can install
‘or enable it by following the instructions on the Windows
‘Management Framework page. :



Network Software Supported operating systems for SQL Server 2014 have
built-in network software. Named and default instances of
a stand-alone installation support the following network
protocols: Shared memory, Named Pipes, TCP/IP and VIA.

Hard Disk SQL Server 2014 requires a minimum of 6 GB of available
hard-disk space.

Disk space requirements will vary with the SQL Server
2014 components you install. For more information, see
Hard Disk Space Requirements (32-Bit and 64 Bit) later in
this topic. For information on supported storage types for
data files, see Storage Types for Data Files.

Monitor SQL Server 2014 requires Super-VGA (800x600) or higher
resolution monitor.

Crystal Reports ° Processor: AMD or Intel based processors, Dual

Requirements Core CPU

. Operating Systems: Windows 7 SP1, Windows 8,
Windows 10; Windows Server versions 2008 SP2,
2008 R2 SP1, 2012

. Data sources: Native, ODBC, OLE DB, and JDBC
connectivity to relational, OLAB Web services, XML,
salesforce.com driver, legacy and enterprise data
sources.

The desktop based GMIS 2018 application is developed for public
release through Department of Irrigation (DOI), Government of
Nepal. DOI is solely responsible for the content of the software. The
software may not be modified, abridged, decompiled, disassembled,
obscured or reverse engineered. The user is solely responsible for
the content, interactions, and effects of any and all amendments,

if present, whether they be extension modules, language resource
bundles, scripts or any other amendment.



Abbreviations

AMIS Agency Managed Irrigation System
DOI Department of Irrigation
FMIS Farmer Managed Irrigation Schemes

GCA Gross Command Area

GIS Geographic Information System
GUI Graphical User Interface

GW Groundwater

ha hectare

IWRMP Irrigation & Water Resources Management Project

km kilometer

Ips liters per second

m3/s cubic meters per second
m meter

NCA Net Command Area

RS Remote Sensing

Ul User Interface

WMS Water Modeling Solutions Pvt. Ltd.

WUA Water Users’ Association
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GMIS 2018

1. System Requirements

Before installing the desktop based GMIS 2018 application, the
user needs to make sure that his/her computer has at least the
minimum required hardware and software. In order to get the
maximum performance from the application, recommended system
requirements are given below.

Hardware Requirement

Processor 2 GHz or higher quad core processor
Hard disk 50 GB (Min)
RAM 4GB (Min)

Graphics Microsoft DirectX 9 graphics device with WDDM driver
Architecture 64-BIT / 32-BIT

Software Requirement

* Windows 7 operating system (minimum requirement)
e  SQL Server 2008 or above

e _Net Framework Version 4.5 or above

The developer team does not take responsibility over the developed
application’s performance and is not to be held liable if the GMIS
application is installed, tested and used on a desktop computer that
does not meet the above mentioned requirements.

Water Modeling Solutions Pvt. Ltd. 1



GMIS 2018

2. Installation and Uninstall Procedure

The user cannot simply copy files from the installation DVD and
paste it to the desktop computer. The user must use the Setup
program, which decompresses and installs the required filed to the
appropriate directories, as well as registers certain files (.dll, etc.)
with the operating system. As the GMIS 2018 makes use of SQL
Server .... and SQL Studio for database, they have to be installed into
the computer before installing the GMIS 2018 software.

Installation procedure of these prerequisite softwares are given
separately in another document.

Once the prerequisite softwares are successfully installed into the
system, GMIS 2018 shall be installed following the step-by-step
procedures shown below:

Double click in the exe file of GMIS 2018

2. Program installer will guide you through the installation process.
Follow the on-screen instructions carefully and provide input
wherever required.

Uninstall

1.  Open Control Panel.

2. Click Program & Features.
3. Select GMIS 2018.

4. Click Uninstall.

Water Modeling Solutions Pvt. Ltd. 2



3. Getting Started with GMIS 2018

After successful installation of the application into your computer,
you can start the GMIS application in the following way:

1.
2.
3.

Go to Start Menu
Click on All Programs

Click on the GMIS 2018 icon (Alternatively you can also directly
click on the GMIS 2018 icon located in your desktop)

Then login window appears (as shown in Fig. 1 below)

Please enter user name and password that has been provided to
you to login into the program

Fig. 1: Login dialog box

Water Modeling Solutions Pvt. Ltd.
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GMIS 2018

4. Exploring the Components of GMIS
Interface

After login, the main GMIS interface is displayed with the
background image and six buttons in the menu bar (Fig. 2). The
user can carry out the respective tasks of creating, opening/editing,
managing, logging out and viewing the details and help of this
application by clicking on the respective buttons. This document
explains to the users how to use GMIS 2018 application in a step-by-
step manner through the following:

* New Project

*  Open Project

* Log Out
e About
e Help
5 & 0 0@
lew Project  Open Project Manage Data Log Out About Help Lo

Fig. 2: GMIS main interface

Water Modeling Solutions Pvt. Ltd. 4



GMIS 2018

5. Creating a New Project

This module is used to create a New Sub-Project for the specified
Program as shown in Fig. 3.

Sub-Project Name : |

Program : || i

Create Cancel

Fig. 3: New Sub-Project window

The user needs to enter the following information systematically in
this window as shown below:

e  Type the Sub-Project name.
e Select the Program from the drop-down menu.

*  Click Create button to create a new sub-project and start
entering the information

e  Click Cancel if you want to logout without creating any new sub-
project.

Water Modeling Solutions Pvt. Ltd. S5



GMIS 2018

After creating a new project, the user will see a list of buttons on the
left hand side which needs to be clicked to enter the data of the Sub
Project (Fig. 4). When no data is entered the is a red cross alongside
the button. It automatically changes to a green tick once data is
entered and saved into the database.

N q 4 O @ e

New Project Open Project Manage Data Log Out About Help

ln Project Information ‘
4 Location

n Social Information

n Agriculture Information

B Engineering Information

. Ground Water Project Information
4 Economic Information

n Implementation Information

2 Maps

Salient Features

Bl -

Fig. 4: List of buttons for data entry

All the features corresponding to each button for data entry in the list

are explained separately in the following sections for the convenience
of the user.

Water Modeling Solutions Pvt. Ltd. 6



6. Opening an Existing Project

This module is used to open an existing Sub-Project for viewing or
editing its data as shown in Fig. 5.

GMIS 2018

Ragion - Far-Westem Development Region
Zone - |
Dhestnct

Subi-Fromcn Name
Search Resat

Project Name Tipe Dhstnct
T S - axcx Ontetn

Bhadwa Isgation Sub-Froject Rshabiiation Kalsi

Amarawat Imgaton Sub-Progect FRehabiitaton Kads

Saleregad Imoation Rishabitaton Dion

Golghar Bhinisain Imgation Sub-Projsct FRahabiitaton Cindeidhura

Chalaegad Imaghon Sub-Propsct Rashasbilt st Derctula

Chaud Rupal imgation Sub Project Rshabiitation Dadeidhur

Purchun imgaton Sub-Progect Rishabitston Bagrang

Paud Sumayagend Imgation Froject Flshabitsbon Batad

Fig. 5: Open Existing Sub-Project window

The user can search for the existing sub-projects by Region, Zone,
District and Sub-project Name. It has to be noted that the sub-projects
should have already been previously created and stored in the
database. To view all the sub-projects, the user can click on the table
on the lower side of the screen and then simply click on the Search
button above. All the sub-projects stored in the local database will
be displayed in the list (as shown in the above screenshot). Then the
user can click on any of the desired projects from the list and go the
other sections for data entry and editing. From here onwards, the
user will get to view the same screen as shown in Fig. 4. All the steps
after this is the same for Creating a New Project or Opening and Editing
an Existing Project.

Water Modeling Solutions Pvt. Ltd.



7. Project Information

GMIS 2018

The user needs to enter the project information as shown in Fig. 6.

I Project Information

B Location

[ social Information

I Agriculture Information

. Engineering Infomation

B8 Ground Water Project Information
I Economic Information

B Implementation Information

B Maps

Salient Features

Q Documents Upload

Sub-Project Name :
Command Area

Management System

Ghatte Plot Imigation Project Edit

GCA ha NCA ha

O FMIS O AMIS O Jmis ® Others

Program :

Sub Project Type :

Status of Project

Sub Project Comment

Other Information :

Start Date :

End Date :

IWRMP v Add/Edit Program

() New (® Aehabilation

~Select - v

Prepared By - Recomended By :

Approved By : Approved Date : | 2018-03-14
20080421 [F~ | AD
20110422 [J~ | AD

Save Reset

Fig. 6: Project information entry screen

E~

The user needs to fill in the respective fields with the appropriate
data either by typing or selecting from the drop-down menu,
whichever is applicable.

Water Modeling Solutions Pvt. Ltd.



GMIS 2018

S.N. Field Name Data Type Input Method Example

1 GCA (Gross Number To be typed by the user = 150.5
Command Areain  (Real)

ha)

2 NCA (Net Number To be typed by the user = 120.8
Command Area in (Real)

ha)

3 Program Text To be selected from IWRMP
dropdown menu

To be typed by the user

if Add/Edit Program is

selected

4 Sub Project Type Text To be selected using New

radio button

5 Status of Project Text To be selected from Pre-feasibility
dropdown menu

6 Sub Project Text To be typed by the user = The project was
Comment constructed

in 2000 but
later destroyed
and again
rehabilitated in
2010.

7 Prepared by Text To be typed by the user = Ghatte Kulo WUA
8 Recommended by  Text To be typed by the user | DDC .
9 Approved by Text To be typed by the user = DTO

10  Approved date, Date To be selected from 2011-04-12
Start date, End (YYYY- calendar

date MM-DD)

After all the data has been entered, the following steps need to be
followed.

Click Save button to save the information.
Click Reset button to clear and enter again.
Click Cancel button to cancel.

Water Modeling Solutions Pvt. Ltd.



GMIS 2018

8. Location

The user needs to enter the data for Location as shown in Fig. 7.

qujed r——— ;one, District, Local Govt. Body, Ward No: Add/Edit
|§ T Zone District Local Govt. Body Wards
nsodﬂ Te—r Mahakali Dadeldhura SHIRSHE 3
1 Agricutture Information
n Engineering Information
B Giround Water Project Information
I Econonmic Information
B Implementation Information
NMaps Ecological Region :  Hill ]
! oy P Nearest Road Head :  Jogbuda
A Documents Upload Distance : | 10.000 K

Nearest Aiport ©  Dhangadhi

Distance Km
Nearest Market :  Dadeldhura Bazar
Distance Km
Major River Basin : v %l

Local River Basin :

River Source :  Rangoon Khola

Fig. 7: Location information entry screen

The user needs to fill in the respective fields with the appropriate
data either by typing or selecting from the drop-down menu, radio
button, etc. whichever is applicable. The following data needs to be
entered:

Water Modeling Solutions Pvt. Ltd. 10



GMIS 2018

S.N. Field Name Data Type Input Method Example

1 District Text To be selected from Dhankuta
5 drop-down menu

2 Local Govt. Body Text To be typed by the user Bhimeshwor

: Gaupalika

3 Ward No. Number  To be typed by the user 10

5 (Integer) :
4 Nearest Road Head, Text To be typed by the user ~Ram Janaki Sadak

Nearest Airport,
Nearest Market,
Local River Basin,
River Source

5 Distance (km) Number To be typed by the user Puwa Khola
: (Real)

6 Ecological Region Text To be selected from 15.6

5 drop-down menu

7 Major River Basin ~ Text To be selected from Hill

5 (View button is drop-down menu

available alongside
to View ..... the river
basin reference

map) :
8 Local River Basin Text To be typed by the user  Ghatte Khola Basin
9 River Source Text To be typed by the user Rangoon Khola .

After all the data has been entered, the following steps need to be

followed.
e Click Save button to save the information.
* Click Reset button to clear and enter again.
e Click Cancel button to cancel.

Water Modeling Solutions Pvt. Ltd. 11



GMIS 2018

9. Social Information

The user needs to enter the social data as shown in Fig. 8 below.

I Project information Mumberof Housshold 1 [110 | Women Headed Housshold : | |

i Locavon TotalPopulation: |0 | Male : | Female : | |
B Agrcuiture nfommaton Annual income perFamiy: | | FromAgicutwe: | From Other Sowces: | ]
m=GumWnarﬁqﬂHanulm Ll | i Wele : | Famals : | |
.iEﬂtr:m:Hmmwon [Ethnic Groups :

(G impiementation infoamaton

1 aps

=

Annual Migration In

Land Tenure : Muribser ertage
geen —w I
[ 3 100 100.00

Farm Size :

5 hectare)
medium (0.5 - 1,0 hectare)
large (1.0 - 1.5 hectare)

Fig. 8: Social Information entry screen

The user needs to fill in the respective fields with the appropriate
data either by typing or selecting from the drop-down menu,
whichever is applicable. The following data needs to be entered:

S.N. Field Name Input Method Example

1 Number of Household Number To be typed by the 10
: : (Integer)  ‘user :

2 éWoman Headed HH éNumber éTO be typed by the 5
(Integer)  user

éYear of Survey éDate ETO be typed by the 2017
: (YYYY) user
4 éMale éNumber éTo be typed by the 2000
(Integer)  user :
5 Female ‘Number éTo be typed by the 1800

((Integer) user

Water Modeling Solutions Pvt. Ltd. 12



GMIS 2018

rield Name InpucMethod ____xample

: Ma]or Source of Income

Annual income per fami-
ly (Rs), From Agriculture
(Rs), From Other Sources

éLiteracy Rate (%), Male
(%), Female (%)

éAnnual Population
‘Migration In

éAnnual Population
‘Migration Out

éLand Tenure (Household
‘Nos.)

éFarm Size (Household
‘Nos.) Category

If Deficit is chosen, Numberé

Text "To be selected from Agrlculture
;drop down menu

‘Number ' To be typed by the user 100000

(Real)

Number :To be typed by the user :43.5%

(Real)

- Text éTo be selected from Dhimal

' -drop-down menu

éNumber To be typed by the user 200

(Integer) :
Auto-calculated 4.6%

éNumber To be typed by the user 1000

(Integer)

éNumber To be typed by the user 1500

(Integer)

- Text éTo be selected from éLand
-drop-down menu ‘Owners

éNumber To be typed by the user 200

‘ (Integer) :

Number :Auto-calculated 7.2

(Real)

- Text To be selected by the éLarge (1.0- ?
user 1.5 hectare)

éNumber To be typed by the user :50

(Integer) :

Number  :Auto-calculated 35

(Real) 5

- Text éTo be selected from Sufficient
-radio button

Number :To be typed by the user 3

(Integer)

-of months

After all the data has been entered, the following steps need to be

followed.
e (lick Save button to save the social information. The user
will be able to see all the added data in tabular format in

the same screen.

* Click Reset button to clear and enter again.
* Click Cancel button to cancel.

Water Modeling Solutions Pvt. Ltd.
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10. Agricultural Information

The user needs to enter the agricultural data as shown in Fig.9 below.

:-Seuuﬂm

GMIS 2018

!iwnmm

| B Engineering Information

IR Ground Water Project information
| Economic infommation

[ iz

Esisting Croppang Pattem
Crop Mame : | - Salect — w Planting Dae : | January w | First wask W
Crop Area : ha Harvesting Diate ; |Janusny W | First wask W
Average Crop Yield tanha
Avvarsge Farm Input
Seed : kg/hs DAP kg/ha  Human Labar Motha
Orgarc kg/ha Patash kg/ha  Anmal Labar Ma/ha
' Urea kg/ha Machine Labor he/ha
Add Cancel
Crop Hame Crop Area (ha) Avg. Crop Yield gorvha)  Planting Date Harvesting Date Seed
Paddy 29.00 20 June, Sacond Weak Movembar, First Ve
Maize 13.00 19 March. Second Week June. First Week
Puise (Legume) 2.00 0.7 December, Second Week March, First Waek
Diseed 200 05 December, Second Week March, First Week
Wheat 25 M 15 Nowember Secnnd Winek Marrh First Viink
< >
Proposed Croping Pattem
Crop Mame © | - Selact ~ Plarting Date : | Janwuary w | |First Week w
Crop Area ha Harvesting Date : | January ~ | | First Wesk ¥
Fverage Crop Yiek : torvha
Average Fam Input
Seed : kgtha DAF - kg/ha  Human Lsbor Mao/ha
Orgaric kg/ha Fotash - kg/ha  Animal Labor Mosha
: Lirea : kgsha Machine Labor heha
Fdd Cancel
[ crom Mame Grop Ares hal A, Cree Yield tonvhal  Planting Date Hervesting Date Seed kal

Fig. 9: Agricultural information entry screen

The user needs to fill in the respective fields with the appropriate
data either by typing or selecting from the drop-down menu,
whichever is applicable. The following data needs to be entered:

S.N. Field Name

Data Type Input Method

1 Crop Name gText
2 Planting date & week Text

..............................................................................................................................................................................................................

5 éAverage crop yield in ton/ éNumber

‘ha

(Real)

Water Modeling Solutions Pvt. Ltd.

To be selected from
-drop-down menu

éTo be selected from
-drop-down menu

ETo be selected from
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GMIS 2018

S.N. Field Name Data Type Input Method Example
6 éAverage Farm Input Seed in: Number éTo be typed by the user 100
: ‘kg/ha  (Real) :
7 DAP in kg/ha Number ETo be typed by the user :85
(Real)
8 ‘Human labor in mandays/ :Number :To be typed by the user :15
‘ha - (Real)
9 Organic Manure NRs/ha Number :To be typed by the user 5000
(Real)
10 :Potash in kg/ha Number :To be typed by the user :60
(Real)
11 :Animal labor days/ha Number :To be typed by the user :20
(Real)
12 :Urea in kg/ha Number éTo be typed by the user :65
(Real)

‘Once the data has been entered for a crop click Add button to store it in grid.
-The user can then enter the information of another crop.

éThe exact same procedure that is mentioned above is to be followed for the
 Proposed Cropping Pattern also.

14 éNearest Agriculture éText gTo be typed by the user Sahablr
3 ‘Extension Office, Nearest . Agro-Vet Pvt
- Agro-vet Center Ltd.
15 Distance in km Number To be typed by the user :2
(Real)

After all the data has been entered, the following steps need to be

followed.

* Click Save button to save the Agricultural information. The
user will be able to see all the added data in tabular format
in the same screen.

* Click Reset button to clear and enter again.

e Click Cancel button to cancel.

Water Modeling Solutions Pvt. Ltd. 15



GMIS 2018

11. Engineering Information

The user needs to enter the engineering information as shown in Fig.

10 below.
e 1
il Location | Catchment Area : km River Width &t Headworks ste m
Bl socsal nfeaaion Longitudinal Slope of Riverat : 1 VH) Average Annual Rairfal m
Agricuture ommation Headworks site
= — | Flood Discharge ;25 Years cumec: 50 Years cumec: 100 Years cumec
I Ground Woter Project Infomation hethod of Rood Calcuiction : MIP (2016) Hycologcal Region - v
1 Economic Information
> = e = Canal Direction FRight v Neot >
Implementation Infomation
o r Main Canal
oo Total Length : | 1.000 km
I Summary Reports J Lined Type Canal Langth : [0.200 K UnLined Type Canal Length - | 0.800 km
= Design Discharge : | 0.470 cumec
Top Width : m Bottorn Width : m Total Depth : m
Side Slopa 1 (VH) Longftudinal Siops = 1: (VH)
No. of Branch Canal : Branch Canal Length : |2.950 km
Head Works Type : | Side sk
Canal Structure : Structure Type Mo of Structure
T
Drop Structurss -5
| VRE/Foot Bridge -4
Branch Canal
Name of Branch Canal
GCA: ha CCA- ha
Total Length an
Tined Tuna Canal | anceh - | e Uinined Tune Canal 1 aneth + | Jom

Fig. 10: Engineering information entry screen

The user needs to fill in the respective fields with the appropriate
data either by typing or selecting from the drop-down menu,
whichever is applicable. The following data needs to be entered:

S.N. Field Name Data Type Input Method Example

1 River Hydrology éNumber éTo be typed by the user 122.5
' -Catchment Area in sq. km  (Real) ' 5

.............................................................................................................................................................................................................

2 éRiver Width at Headworks éNumber ‘To be typed by the user 30.78
5 site in m (Real) 5 5

3 éLongitudinal Slope of River éNumber éTo be typed by the user 1000
: ‘at Headworks site in 1:n  : (Real) : :
- (V:H) format

4 éAverage Annual Rainfall in éNumber éTo be typed by the user 1353.7

‘mm (Real)
5 ;Flood Discharge ;Nurnber ;To be typed by the user 1500
' - corresponding to return - (Real)

-period of 25 years, 50 years '
‘and 100 years in cumecs

Water Modeling Solutions Pvt. Ltd. 16



GMIS 2018

S.N. Field Name

6 gMethod of Flood Calcula-
tion

Text

Data Type Input Method

Number
(Integer)

éMain Canal Information

Example
To be typed by the user DHM-
- WECS

' Method
To be selected from the 12
-drop-down menu '
Auto-generated Ratabhira

‘Khola
Auto-generated Khahare

‘Khola Basin
éTo be selected from the ' Left

“drop-down menu

Click on the Next> > :
‘button to toggle between !
left and right canals '

..............................................................................................................................................................................................................

Number
(Integer)

To be typed by the user 20
To be typed by the user :7.6
To be typed by the user 12.4
To be typed by the user 5200
To be typed by the user 225.4
To be typed by the user 220.2
To be typed by the user 1.3
To be typed by the user 25
To be typed by the user 6.8
To be typed by the user 5

10
-Canal Direction

11 éTotal length in km

12 éLined type canal length in
‘km

13 éUnlined type canal length
‘in km

14 éDesign discharge in Ips

15 ;Top width in m

16 EBottom width in m

17 éTotal depth in m

18 ELongitudinal slope in 1:n
- (V:H) format

19 éBranch canal length in km

20 éNo. of branch canal

21 ;Major Structure Type

éTo be selected from the
-drop-down menu

Super

Number
(Integer)

Water Modeling Solutions Pvt. Ltd.
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S.N. Field Name Data Type Input Method Example

23 Branch Canal information éNumber éTo be typed by the user Bariya
' Name of Branch Canal (Real) ' :

24 Gross Command Area éNumber To be typed by the user | 34.5

'CCAinha - (Real)

(Real)
27 éLined type canal length éNumber ETo be typed by the user 1.2
type in km - (Real) : :
28 éUnlined type canal length éNumber éTo be typed by the user 1.8
-in km - (Real) 5 5
29 gNumber To be typed by the user :35.5
(Real)
30 ;Number éTo be typed by the user |6
(Integer) 5
31 éNumber To be typed by the user :8.6
(Real)
32 Text To be typed by the user gUnderpassage

After all the data has been entered, the following steps need to be

followed.

* Click Save button to save the Engineering information. The
user will be able to see all the added data in tabular format
in the same screen.

* Click Reset button to clear and enter again.

e Click Cancel button to cancel.

Water Modeling Solutions Pvt. Ltd. 18
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12. Ground Water Project Information

The user needs to enter the groundwater related data for the sub-
project as shown in Fig. 11.

I Project Information

- Location

B Social infomation

B Aaricuiture Information
. Engneering Information

T Ground Water Project

1 Economic Irformation

B implemertation Information
Bl Maps

[ Summary Reparts

Well Information
No. of Wels :

Type of Wells :
Tube Wel Spacing :
Topegraphy, Geology and Hydrology of the area

Topographic and
Geological Situation :

Aauifer Type :

Aquifer Materials :

Discharge : T
Static Water Level - |
Pump Parameter
Brand of Pump
Horsepower : |
Head :
Efficiency of Mator/Engine : |

Distribution System
Open Channel System :
Buried Pipe System :
Qutlets :

v Well Depth - Im
m Size of Tubewels | m
s Drawdown : | m
m Transmissivity : m/d
hp
m Pump Discharge : I/s
% Efficiency of Pump : | %

No of Branch Channel :

% Main Channel Length : km

Fig. 11: Groundwater information entry screen

The user needs to fill in the respective fields with the appropriate
data for each Tubewell (identified by Tubewell Number) either
by typing or selecting from the drop-down menu, whichever is
applicable. The following data needs to be entered:

S.N. Field Name

1 Tubewell No. Number

2 Tubewell Information Text
‘ Location 5
3 Latitude in decimal degrees éNumber
- (Real)
4 éLongitude in decimal fNumber
degrees (Real)
5 Elevation in masl éNumber
(Real)
6 Type of tubewell Text

Water Modeling Solutions Pvt. Ltd.

Data Type Input Method

- (Integer)

............................................................................................................

Example

éTo be typed by the user 7

..................................................................................................

To be typed by the user : Gauthali-
chaur

To be typed by the user :27.673459

To be typed by the user :83.497652

ETo be selected from the EDeep
-drop-down menu '

19
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S.N. Field Name

7 éTubewell housing pipe size éNumber éTo be typed by the user

Data Type Input Method

Example

1100

8 ETubewell screen and casing ENumber

- pipe size in mm

(Real)

ETo be selected from the
-drop-down menu

‘m/day

19  Distribution System
‘information

- Type of distribution system

20 ELength of open channel in

Number
(Real)

éTo be selected from the
-drop-down menu

..............................................................................................................................................................................................................

Number
(Integer)

‘in mm

ETo be selected from the
-drop-down menu

..............................................................................................................................................................................................................

Number
(Integer)

Water Modeling Solutions Pvt. Ltd.
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S.N. Field Name Data Type Input Method Example
27 éPower in HP éNumber éTo be typed by the user éKirlosker
: - (Real) : 5
28 éHead in m ENumber éTo be typed by the user 1.5
5 (Real) : 5
29 Pump discharge in Ips Number (Real) éTo be typed by the user .

30 Efﬁc1ency of motor in % Number (Real) éTo be typed by the user .

34 ;Column type éText éTo be selected from the 100
5 5 -drop-down menu 5

35 Pump House information :Number (Real) éTo be typed by the user MS
Size of pump house (length : : :
x breadth x height) in m

36 gHeight of overhead tank éNumber (Real) éTo be typed by the user §4x4x3.5

...............................................................................................................................................................................................................

37 Volume of overhead tank in : Number (Real) éTo be typed by the user 45
cub1c meters ' 5 5

38 Electrlﬁcatlon information Number (Real) éTo be typed by the user 25
‘Length of 11 kV HT : : :
‘transmission line in m

39 ELength of 440 VLT éNumber (Real) éTo be typed by the user 2850
‘transmission line in m 5 ;

40 éNumber of poles éNumber éTo be typed by the user 10
: (Integer) : :

41 éTransformer capacity in éNumber (Real) éTo be typed by the user 12
‘KVA : :

43 éVoltage stabilizer in KVA éNumber (Real) éTo be typed by the user 10

The data shown in the above table has to be saved each time the user
adds data for a new tubewell. After all the data has been entered, the
following steps need to be followed.

* Click Save button to save the Ground Water Project
Information.

* Click Reset button to clear and enter again.

* Click Cancel button to cancel.
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13. Economic Information

The user needs to enter the Economic information for the sub-project
as shown in Fig. 12.

B Project Information Economic Information
B Location
Bl ocial kfomation Total Project Cost: NRS Bt | €5.23
Bl Agicuture infomation Costing Year : (2000 v AD Discount Ratel | %
Ffematin =

i Ergneerrg EIRR - % BAC2: g 23
B Ground Water Project Information
[ i bk x Discount Rate2 :
P inpiementatian Infomaton Add Cancel

Cost Costng Year  ERR(W  BC1 Discourt Rate (%) BC2 Discourt Rate2 (%) Cost /ha
B aps
I surmary Rpors TS 2010 177 7 0 163630

Save Resat | Caneel

Fig. 12: Economic information entry screen

The user needs to fill in the respective fields with the appropriate
data either by typing or selecting from the drop-down menu,
whichever is applicable. The following data needs to be entered:

S.N. Field Name Data Type Input Method Example

1 Total project cost in NRs éNumber ETO be typed by the user 105480

: (Integer)

2 Costing year in AD Date ‘To be typed by the user 2017
5 (YYYY)

3 EEIRR in % éNumber To be typed by the user :15.6
: (Real)

4 EBeneﬁt/ Cost B/C ratio 1 éRatio To be typed by the user :2:3

‘and 2
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Once one set of data has been entered, the user needs to click on the
Add button. The current data will be displayed on the table in the
same screen. The same process needs to be followed for adding all
the datasets. Click Cancel button to cancel the data entry.

After all the data has been entered, the following steps need to be
followed.

e Click Save button to save the Economic information. After
clicking Save button, the user will see the entered data in
the table.

* Click Reset button to clear and enter again.

e Click Cancel button to cancel.

Water Modeling Solutions Pvt. Ltd.
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GMIS 2018

The user needs to enter the data for Implementation Information as

shown in Fig. 13 below.

WUA Share : | 736552 550 | NRS

No. of Participants : |

" Cancel

No. of Participants

T - Progress Monitoring
i Project Information GON Share : |6629027.020 | NRS
| Il Location
== cal Proy
I. Sodial Information S =
| pgrcuture infomation Physical Progrese Date : 2010-03-03 EMEY
. Engineering Information
.ernd Water Project Information Financial Progress :
(I Econamio kiomaton
|ilmulemeridion Information Financial Progress Date ; | 2010-03-04 e AD
i repe
ary e Institution Monitoring
| i Summary Repo Mo
| = WUA Office :
WUA Registrtion Date : 20100304 9| ap
'WUA Registration Training
Training Name : | §
Treining Period : | Days
Add
Training Mame Training Perod
Save Reset

Fig. 13: Implementation information entry screen

The user needs to fill in the respective fields with the appropriate
data either by typing or selecting from the drop-down menu,
whichever is applicable. The following data needs to be entered:

S.N. Field Name Data Type Input Method Example

gTo be typed by the user 500000

1 Progress Monitoring infor- Number

-mation  (Real)
- Government of Nepal '
:GON Share in NRs :
2 éWater Users Association éNumber éTo be typed by the user 100000
- WUA share in NRs (Real) 5 5
3 Number ;To be typed by the user ;500000
(Real)

Water Modeling Solutions Pvt. Ltd.
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S.N. Field Name Data Type Input Method Example

4 EPhysical progress date in EDate ETo be typed by the user 5201 7-03-08
5 ‘MM-DD)

5 éFinancial Progress éText éTo be typed by the user 225%

5 5 5 ‘completed;
- satisfactory

6 éFinancial Progress Date in :Date ‘To be typed by the user 2017-03-08
‘AD C(YYYY-

' MM-DD)

7 éInstitution Monitoring éText éTo be typed by the user Satmule
:WUA Development Office :Water Users
‘Name, Number of WUA - Association,
-members, Registration 35, Bara
‘place : : :

8 EWUA Registration date in éDate éTo be typed by the user 52015-02-10
'AD (YYYY-

; ‘MM-DD)

9 EWUA Training information éText éTo be typed by the user éOrientation

- Training name training

10 éTraining period in days éNumber éTo be typed by the user 15

11 Training date in AD Date “To be typed by the user 60
‘:MM-DD)
12 ENO- of participants éNumber ETO be typed by the user 22

(Integer)

Once one set of data has been entered, the user needs to click on the
Add button. The current data will be displayed on the table in the
same screen. The same process needs to be followed for adding all
the datasets. Click Cancel button to cancel the data entry.

After all the data has been entered, the following steps need to be
followed.
* Click Save button to save the Implementation information.
After clicking Save button, the user will see the entered
data in the table
* Click Reset button to clear and enter again.
* Click Cancel button to cancel.
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15. Salient Features

The system provides summarized reports of the sub-project in
the form of salient features. There is another separate section for
generation of individual reports.
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16. Document Uploads

To upload document, simply click in the document upload tab and
follow the steps accordingly. Any number of documents can be stored
of project and sub projects.

Date of Document Upload

Files Cumrently Available for viewing -

File Name Documert date

Fig. 14: Document Upload Panel

Water Modeling Solutions Pvt. Ltd.
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17. GIS Mapper

The user needs to click [Enaes on the left panel. The user
will view the map as shown in Fig. 14 below. The map will have a
basemap of the district in which the Sub-Project is located.

File

o Lg | ¢ 1;;::'3'\ -xO ":‘@D @cﬁ’i'_?
Legend
B £ Map Layers

= [¥] GORKHA

e Click Add Layer ‘@ button to add a new shape file (point/
line/polygon) to the map.

e  Use Navigation Tools to Pan, Zoom In, Zoom Out, Identify and
more.

D t{l ':{|_ E:.E k{_\ ‘l C} e L . E‘ \@/

* As an example locate the “DhunwakotCommand Area.shp”
shape file in your hard drive and click Open.

A O Name Date modified

i Type

& Crossingl
EA| | DhunwaketCommandArea.shp
DhunwakotGatel.shp

| DhunwakotGates.shp
| Dhunwakotintake.shp
DhunwaketMainCanal.shp
DhunwakotSecondaryCanal.shp 3/6/2018 10:33 AM  SHP File
Wi Gatel F F

& MNepal Government Loge

v < 3

£ name: | DhunwakotCommandArea.shp ~ | | All Supported Formats b
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Dhunwakot Command Area polygon will be added to your map
as shown in the Figure below. Please note the added shapefile on
the bottom right of Gorkha district.

File
B4 e EH @ & (o I i = A O
Legend
= £ Map Layers
= (¥ DhunwakotCommandires

I i §
¥ T k4
| e $
L
1

= ¥ GORKHA

From the left hand List of Shapefiles in the left hand pane, right
click on the DhunwakotCommandArea and select Zoom to Layer

File
2B QAQAHEOIEQ "L ®FE %
-egend
= £ Map Layers i
= V] DhunwakotCommg=- L
El A Remove Layer
= ¥ GORKHA Zoom to Layer l“x
[] [7] Attribute Table Editor {
| ] Set Dynamic Visibility Scale
Data »
Labeling »
‘) Selection »
@ Properties e
¥ Join Excel file 'Data’ Label
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*  You will get the following view of the map.

s @ el e B iR @B LR
Legend
E & Map Layers 'f?‘T'L g
= ¥ DhunwakotCommandérea e ('I
H R
5 V] GORKHA R -

* To create new point (for example, location of Intakes (or gates,
bridges, etc.) click )

e In the Create New Layer dialog box, select Point from the
dropdown menu and give a Filename “Gatel” and click Select.
Give the location in your computer to save the file and click OK.

Create New Layer X
Featuretype Point “
Filename I Select

[] include M Values [] Include Z Values
Ok Cancel

e  Click Add Shape # button to add coordinate points for
longitude and latitude as X and Y as shown below.

Coordinate Dialog X

X: [84.5220740698279 |

Y: [27.9770327964798 |

Ok Close

Water Modeling Solutions Pvt. Ltd. 30



e  (Click OK button to add the point.

e Right Click Point Layer button and choose Export data as
shown below.

=l £% Map Layers
= V] New-~

x Remove Layer
=) Doti E Zoom to Layer
i [ Attribute Table Editor
|| Set Dynamic Visibility Scale

Data ’ El Export Data "

4

Labeling »

Selection >

L%
@ Properties
% Join Excel file 'Data’ Label

e  Click Export Data button and following window appears.

Export Feature Data X

Export: All Features x

Output shapefile or feature class:

OK Cancel

e  Provide the appropriate file name and save it in required folder.
When asked to load the shapefile choose Yes. The newly added
layer will be displayed in the left hand list and also in the map.

Note: Do not delete the intermediate layer, it might cause the
system to hang or close unwantedly.

Water Modeling Solutions Pvt. Ltd.

GMIS 2018

31



* Try varying the symbology (example, colour, opacity, point type,
size of the added layers by double clicking on the symbol just
below the layer name in the left-hand list. The symbology tab
will appear as shown in the figure below.

GMIS 2018

Water Modell

Point Symbolizer Dialog ? x
Scale Mode: | Symbolic w
B Smoothing Uns:  Piel w
Symbol Type: | Simple w
Simple Add to Custom Symbols
Style: Rectangle bl
Placement
“ ol g,
LY
e Pawm
; Angle: i
[ tee { — 0%
Outine Wicth: |1 '
(faet
Outiine Color: f
L ) o 1 ¥ iu
e X+ P
I
Polygon Symbolizer Properties ? x
[T ooz Ounct
Preview:
Scale Mode: | Simple v
[] Smoothing Units: | Ppeel w
Pattem Type:  Simple
Simpile
F Use Outline Edit
Fill Color:
Width: |1
0 Outine Color:

Add To Custom Pattems

oK Cancel Apply

32



* Click [[]| from the menu Attribute Editor button or right click
on the layer list to view the attribute table.

|1 Astribute Table Editar

Edt  View Selection Took
QA Ee
(F0

In Memary

- u] X

1ol 5 selected.

e Try adding fields with data.

e  Click Apply to save the edits and click Ok.

Attribute Table Editor
Edit | View Selection Tools

Remove Field
Rename Field

Enable Editing

Water Modeling Solutions Pvt. Ltd.
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gp Create Field - O *

Field Name | Well No |

Data Type [T v]
s [0 3
ok || Concdl | Aoy |
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* To add labels to the map, right click on the left hand layer list
and click on the Label Setup. Select the field from which value
is to be used for the label by double clicking as shown in the
figure below. You can adjust the label properties using the other
properties tabs. Click Apply and OK. The label should appear on
your map.

[

g #

Remove Layer

Zoom to Layer

Attribute Table Editor

Set Dynamic Visibility Scale
Data >
Labeling » | Label Setup

Selection » [[L] SetDynamic Visibility Scale
Properties

Join Excel file 'Data’ Label

FEEX

$ & A

I Feature Labeler ? K
Categories: Expression  Basic Properties  Advanced Properties  Members

Result:
Field Names
Narme Datatype Newine | Vaidate
Int32
Example
MName String [vea] + "ha”
FID Int32 [Population] 1000 + "thsnd.”

Descriots
[frea] = name of the field
ha" = sting "
+-/" = aithmetic operators
+ = concatenates

. o
(] [3¢] [#] [*]

Use the Expression Tab to design the text that should

appearin a label. Fields indicated with brackets wil be . o :
substitided with real values. [ok ] Cance | Aoy |
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* To save the map project, click on File Save or Save As. In the
dialog box, browse to a folder and give a suitable name to the
project. Note that the extension of the project file is .dspx

File |
MNew
Open...
' B Save
|_[:-_J- Save As...
. Options
= Print Layout...
oy Reset Window Layout
Exit

File name: [|

Save astype: Project File (*.dspx) ~

» Hide Folders Cancel

* Next time when you want to open the project, locate the .dspx
file that you have saved in the respective folder from the File >
Open menu. All the elements of the map will be displayed as you
have saved it in your previous session.
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18. Print Layout of Maps

After your map is ready, click on File Menu> Print Layout. You will
get a new window as shown below.

(&) DotSpatial Print Layout — O X
File Select View
PeER8 ARANm - EEDME E4+=Z=HMNOONR
Map 1
[#][3] x
e

This opens a DotSpatial Print Layout window where you can
organize content for printing. You can zoom in and out of the layout
by clicking the Zoom In and Zoom Out buttons at the top of the
window.

e In the DotSpatial Print Layout window, click the Insert map
button [ to activate that tool.

e  Using the left mouse button, draw a box on the layout to
position your map.

Water Modeling Solutions Pvt. Ltd.
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The map fills the box that you drew. This is how all of the tools work
that insert elements into the layout.

Note: Do not add more than one type of element to the layout. For
example, don’t add two text boxes or two images. This is a known
bug that may cause the program to freeze.

e  (Click the Insert north arrow button "*" to activate that tool.

e  Using the left mouse button, draw a box on the layout to
position your north arrow.

You can click and drag to move elements or resize them once they
have been added to the layout.

e Click the Insert legend button E to activate that tool.

e  Using the left mouse button, draw a box on the layout to
position your legend.

The legend currently includes all visible map layers. With the new
legend still selected, in the properties of the legend in the lower right
corner of the window, click the word Layers to give that item focus.

o 21l
“ Layout
Location 0.0
Mame Map 1
Size 540, 498
v Map
Scale 16877
v Symbol
Background [Edit...]

Water Modeling Solutions Pvt. Ltd.
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*  (lick the drop-down arrow to the right of the word (Collection).

e  Click anywhere in the layout to confirm the changes. This is
how you change properties of other layout elements as well.

e (Click the Insert scale bar button }_f to activate that tool.

e  Using the left mouse button, draw a box on the layout to
position your scale bar.

e  Click the Insert text button 4 to activate that tool.

*  Using the left mouse button, draw a box on the layout to
position a title for the map.

e Click the Insert rectangle button [ to activate that tool.

*  Using the left mouse button, draw a box on the layout around
the scale bar, north arrow, and legend to group them together
aesthetically.

*  Click the Insert bitmap button @@ to activate that tool. The
tool prompts you for the location of the image file that you want
to insert. You can insert pictures taken in the field, logos of the
organization preparing the map, graphs and other information if
they are in bit map format located in your hard disk.

e  Using the left mouse button, draw a box on the layout to
position the logo.

* Save your layout by clicking File and then Save. Specify the
name and location of your choosing. Please note the map layout
is saved in .mwl format.

e In the DotSpatial Print Layout window, you can choose the
option of Select>Convert to Bitmap and specify the name and
location of the map in jpg, png, etc.

* In the DotSpatial Print Layout window, click File | Choose
printer to specify the printer to use.

*  Click File | Print to print your layout.
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